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�
Welcome





We created the Microsoft¨ Bookshelf¨ 1996-97 Edition Teacher’s Activity Guide to introduce K�12 teachers like you to Bookshelf 1996-97 Edition. This Guide will help you find ways to integrate Bookshelf 1996-97 into your classroom curriculum.


As you use the Microsoft Bookshelf 1996-97 Edition CD-ROM reference library, you’ll see that this multi-media resource combines a variety of elements—text, audio clips, video clips, animations, photographs, charts, and illustrations—which makes it an excellent resource for students no matter what their learning style may be.


With Bookshelf 1996-97 Edition, the process of finding information is interactive and engaging. The format encourages investigation, experimentation, and browsing. Students working individually or in teams develop research skills and strategies as they locate the information they need.


In the school library or classroom, whether you have one computer serving as an information station or a fully equipped classroom or lab, your students can use Bookshelf 1996-97 Edition whenever they need to confirm a statistic, view a map, hear a word pronounced, investigate an idea, or locate data for a report or paper. 


Simply put, Bookshelf 1996-97 Edition provides quick and easy access to a world of information.





�
Books in Bookshelf 1996-97 Edition


Microsoft Bookshelf 1996-97 provides quick access to a world of information. �A multimedia library that includes the most frequently used reference books available, Bookshelf is an easy way to gain access to the information you need. �Extensive use of multimedia sights and sounds brings the information to �life—with images, dictionary pronunciations, video clips, animations, and spoken quotations.


Microsoft Bookshelf Internet Directory 96 


This new addition to Bookshelf 1996-97 Edition includes access to nearly 5,000 current Internet sites.


•	Need to find some up-to-the-minute information? Can’t locate a World Wide Web address for the topic you are researching? Use the Internet Directory. Monthly address updates from the WWW will keep this book a valuable, up-to-date reference.


Concise Microsoft Encarta¨ 96 World Atlas 


The Atlas is your resource for maps of the continents, countries, and regions, with topographic detail. Over 50 maps in total.


•	Audio pronunciations of country, city, and U.S. state names, audio clips of national anthems, and links to the Encyclopedia and Almanac bring new dimensions to this reference.


The American Heritage Dictionary of the �English Language, Third Edition 


This edition has more than 350,000 entries, including brief biographies, geographic definitions, and pronunciations. There are over 1,000 images and 80,000 words pronounced.


•	Want to hear how a word is pronounced? Just click on the audio icon. The audio component of the Dictionary allows you to actually hear a word or name spoken.


The Original Roget’s Thesaurus �of English Words and Phrases 


Newly revised for the language of the 1990s, with over 250,000 words, phrases, and expressions, this is an essential writing tool in a convenient format. 


•	Want to research related word or phrases? Click on a linked word or phrase to display the related entry. Bookshelf Infinite Links allow immediate accessibility and encourage inquiry and exploration. 


The Columbia Dictionary of Quotations 


This reference has more than 18,000 lively remarks, judgments, and observations on 1,500 subjects. The book is arranged by subject matter and speaker. Within subjects, you’ll find the quotations listed alphabetically by speaker.


•	Need a quotation to make a point in your presentation or paper? Use the Outline to view subjects by category and find just the right quotation you need.


The Concise Columbia Encyclopedia, Third Edition 


The Encyclopedia contains over 17,000 short entries on a wide range of subjects. These include animations, musical samples, and over 1,700 images.


•	Multimedia clips that include audio descriptions and animations illustrate processes such as circulation, eclipses, and tides. 


The People’s Chronology 


A comprehensive record of events that have shaped our world, this resource enriches the traditional view of history.


•	Need to trace the development of an idea or movement over a period of time? Use the Chronology to jump to related topics for additional background information.


The World Almanac¨ and Book of Facts 1996 


With over one million entries, this is the general reference book of statistical data, contemporary facts, geographic information, and trivia.


•	Need up to data and accurate information? The Almanac was updated for 1996 with the latest facts and statistics.


National Five-Digit Zip Code and Post Office Directory 


This guide provides you easy access to over 50,000 postal codes in the United States.


•	Writing a letter to Big Sky, Montana? Iowa City, Iowa? Use the Address Builder on the Tools menu to find the ZIP code and copy it into a letter or envelope you create with your word processor.


�
Macintosh Version of �Bookshelf 1996-97 Edition


Microsoft Bookshelf 1996-97 Edition offers several features especially designed to support Macintosh¨ users. It includes built-in features especially designed to take advantage of Apple Core technologies. These features are exclusive to the Macintosh version, and some represent a first for Microsoft.


New Apple Core Technologies


Power Macintosh¨ Native�Bookshelf 1996-97 Edition is the first Microsoft multimedia title offering native support for the RISC processors in Power Macintosh models. Bookshelf 1996-97 runs in native mode with either Power PC or 68K processors. What this means for users is faster performance, quicker scrolling, and a snappier overall feel to the user interface.


Apple Guide�Bookshelf 1996-97 is the first Microsoft product to support Apple Guide, the new interactive help system that walks you through complex tasks. When you want to perform a task—say, looking up a ZIP code—Apple Guide provides step-by-step instructions. It tells you exactly what to do, even providing “coach marks” by drawing a red circle around the instruction you’re given. Then, if you don’t perform the instruction, Apple Guide uses scripting to perform it for you. (The actual command is executed with an AppleEvent, explained below.)


AppleEvents�Bookshelf 1996-97 is also the first Microsoft product to support AppleEvents, the advanced, behind-the-scenes scripting function that lets users define and automatically execute custom sequences of events. In addition to scripting for basic AppleEvents such as open, print, and quit, Bookshelf 1996-97 allows users to perform full text searches or context searches. For example, you can use an AppleEvent to search for a word definition in the dictionary or a quote string in a reference book. With Bookshelf 1996-97, users can look up and define words from AppleScriptª, QuickKeys, Userland Frontier or any OSA-compliant scripting environment.


Internet Integration�The Bookshelf 1996-97 Internet Directory integrates with Macintosh Internet applications using its pre-installed Peter Lewis Internet Config and Internet Explorer for Macintosh. This combination of software automatically launches a web browser when you click on a “hot spot” in the Internet Directory or “open URL” in QuickShelf. Just click on the Internet location and the browser automatically goes to it. You can use this feature out-of-the-box with the included software, or set it up to work with your own favorite Web browser.


New Mac QuickShelfª Features


Open URL�When you discover an Internet address (URL) in your mail browser, text editor, or word processor, Bookshelf 1996-97 allows you to simply highlight the Internet resource and select Open URL from the QuickShelf menu. QuickShelf uses Internet Config to automatically launch the correct Internet application to handle that resource, whether it’s a web site, file transfer protocol (FTP) address, e-mail address, gopher site, news list, or other resource.


Define�When you need to check more than just spelling, simply highlight the word or phrase and select Define from the QuickShelf menu. Bookshelf 1996-97 will pop up the definition from the American Heritage Dictionary, complete with pronunciation. Bookshelf lets you go beyond mere spelling checkers, helping you learn what words mean and how they sound, in addition to how they’re written.


Shortcut Menus�Microsoft Bookshelf 1996-97 supports the use of additional shortcut menus throughout the product. These menus are displayed after holding down the Control key and clicking on a word, highlighted phrase, picture, or audio pronunciation icon. In this guide, Control-click is used to display the shortcut menu for Macintosh users; right mouse click is used for Windows users. Macintosh users can also use Option-click in place of the Control-click.


�
Starting Microsoft Bookshelf�1996-97 Edition


Install Bookshelf 1996-97 Edition


If Bookshelf is already installed on your machine, you can move ahead to “Start Bookshelf 1996-97.” For system requirements, see the booklet inside the CD-ROM case. 


Windows 


To install Bookshelf 1996-97 Edition using Windows 95:


1.	Insert the Bookshelf 1996-97 Edition disc into your CD-ROM drive.


2.	Follow the setup instructions that appear on the screen.


To install Bookshelf 1996-97 Edition using Windows 3.1 or Windows NTª 3.51:


1.	Insert the Bookshelf 1996-97 disc into your CD-ROM drive.


2.	Open the Program Manager window, click File, and then click Run.


3.	In the Command Line box, type the letter of your CD-ROM drive, a colon, a backslash, then “Setup.”


	For example: d:\setup


4.	Click OK and follow the setup instructions that appear on your screen.


Macintosh


1.	Insert the Bookshelf 1996-97 Edition disc into the CD-ROM Drive.


2.	Double-click the Bookshelf 1996-97 disc icon that appears on your desktop.


3.	Double-click the Installer icon and follow the instructions on your screen.


	The Installer updates your system, creates a Bookshelf 1996-97 Edition folder on your hard disk and copies the Bookshelf icon and supporting files to the folder.


Start Bookshelf 1996-97 Edition


1.	Place the Bookshelf 1996-97 disc in the disc caddy (if required) and insert it into the CD-ROM drive.


2.	If you are using a Macintosh, click on the folder that contains Bookshelf 1996-97, and double-click the Bookshelf 1996-97 icon. 


	If you are using Windows, click the Start menu, click Programs, click Reference, and then click Bookshelf 1996-97. (If you are running Windows 95 and have just inserted the CD into the CD-ROM drive, it will run automatically.)


Bookshelf Daily 


Every time you start Bookshelf 1996-97, Bookshelf Daily brings you the Quotation of the Day or the Word of the Day. 


To disable the daily word/quote:


1.	Click the Tools menu, then click the Bookshelf Daily command. 


2.	In the Bookshelf Daily dialog box, choose either Word or Quote, then click the checkbox labeled Show at startup to clear it.


�
Exploring Bookshelf 1996-97 Edition


This following pages provide a hands-on introduction to the resources in Bookshelf 1996-97 Edition. After you have worked your way through the suggested activities, you can use the examples to introduce your students to Bookshelf or as a basis for writing lessons of your own.


Before beginning to explore Bookshelf 1996-97 Edition, take a moment to think about what is actually found on the Bookshelf CD-ROM. If you read the first few pages of this guide, you know that Bookshelf 1996-97 Edition contains nine different reference sources. 


Throughout your years of schooling, you were taught to use many of these reference sources. You learned how to locate these sources in a library. You learned what kind of information is contained in each of the references so that you knew which book to use for specific tasks.


Now, all of these books are accessible on a single CD-ROM. Keep in mind that your students may not have been exposed to all of these books individually. For example, while you may be quite comfortable with what a thesaurus is used for, your students may not be, even though they may have already explored the Bookshelf.


As you explore Bookshelf 1996-97 Edition—both for yourself and with your students—keep in mind the huge amount of information that is stored on the Bookshelf CD-ROM. You’ll find more than just the nine reference books—you’ll also find sound, video, animation, and links between all the books, items you don’t find in a regular book.





To help familiarize you with the various resources, we will lead you through a step-by-step exploration. The same topic—Canada—will be carried through most of our examples.


�
Beginning Your Exploration 


When you start Bookshelf 1996-97, you see a screen that gives you access to all of the resources stored on the Bookshelf CD-ROM. Take a moment to examine the various areas of this screen. 


Use the Contents tab when you know the title of the article you want. This tab serves as the table of contents, listing titles for every article in the open book. 


Use the Find tab when you know the word or words you want articles to contain. The Find tab serves as a search tool, listing titles for every article that contains the text you specify. 


Use the Gallery tab when you know the type of media you want articles to contain. The Gallery tab serves as a filter for articles that contain the media type you specify.


The Articles List displays the articles that meet the current search criteria. You can open any of the articles in the list by clicking on the title of the article. Note that a colored box to the left of the title indicates the book from which the article comes. It corresponds to the color of the Book Indicator bar. The article is displayed in the Article Window.


The Back List displays the titles of up to 40 articles that you’ve previously opened. Click the article to which you want to return. 


Use the Year in Review to scroll through important events of 1995. You can jump to an article or hear an audio clip.


Let’s begin by looking at the Table of Contents.


Using Contents Tab 


Using the Contents tab is a good way to look for an article on a particular topic in one or all of the books in Bookshelf. The following step-by-step example will guide you through each book in the Bookshelf 1996-97 Edition as you look for information on Canada.


1.	To search all of Bookshelf, click the Books menu, then click All Books.


2.	Click the Contents tab in the contents panel. 


3.	In the text box, type Canada. 


	You will see a plus sign (+) next to the category Canada in the list of articles. When you click on this icon, you see all of the articles related to the topic “Canada.”


4.	Click the plus sign (+) to expand the list and display the articles.


	No doubt you have noticed the small colored icons next to articles. These icons indicate in which book the article is found. When you move your mouse over an icon, the name of the reference source appears. This feature can be helpful for students dealing with multiple sources for the first time.


5.	Click on the first entry in the list of articles (blue icon). 


	The contents of the Dictionary article you selected are displayed to the right on the Article panel.


Dictionary 


The American Heritage Dictionary in Bookshelf 1996-97 Edition provides users with a fast way to look up the definition of almost any word in the English language. It can be used in conjunction with other applications including Microsoft Excel, Microsoft Word, or Microsoft PowerPoint¨.


In the Dictionary, you can view and listen to the correct pronunciation of a word. The Pronunciation Key explains the phonetic spelling of a word.


 1. To listen to a word’s pronunciation, click on the small speaker next to the word.


	Clicking on this sound icon always lets you hear a sound.


2. To view the Pronunciation Key, click the word’s phonetic spelling, which is in colored text in parentheses. 


	For any word, the pronunciation rules become visible by clicking on the colored text. Click outside the Pronunciation Key window to return to the definition. 


Turning off sounds and pronunciations


Interface sounds and Dictionary pronunciations can be turned off, if desired.


1.	Click the Tools menu, then click the Options command. 


2.	In the Options dialog box, click the Enable Interface Sounds or Enable Pronunciations checkboxes to clear them, then click OK.


3.	Click the Close box to close the Options window.


Copying text, audio, and images


You can copy selected text, audio pronunciations, pictures, or maps to another application, or directly to Word, Microsoft Excel, or PowerPoint.


1.	With the right mouse button (Macintosh users: Control-click) click on the sound icon next to the word “Canada.”


2.	In the shortcut menu, point to the Copy or Copy To command. 


3.	Select the application to which you want to copy the object, then paste it.


Printing an Article


You can print any article, picture, or map in Bookshelf.


1.	Click the File menu.


2.	Click Print Article.


Exploring the Encyclopedia 


The Concise Columbia Encyclopedia is designed for quick reference, rather than in-depth research. However, it is large enough to provide useful information about most topics.


One way to access the Encyclopedia entry for Canada is to click on the icon for the Encyclopedia in the Articles list.


1.	Click on the Canada Encyclopedia entry in the Articles list (the purple icon).


	You see the Encyclopedia article on Canada in the Article panel. Use the scroll bar on the right side of the article panel window to see the information below the bottom edge of the window. 


This information includes text, a flag, and auditory phonetic pronunciations. Country entries such as this also include an audio clip of the national anthem and a link to the atlas, as well as links within the text to other related topics. Maps, pictures, flags, audio pronunciations, and text can be copied into another application or printed. Anthems, video, and animations cannot be copied directly from Bookshelf.


2.	To listen to Canada’s national anthem, click the sound icon.


3.	Click the sound icon again to stop the anthem.


Drilling Down for Details


You can also get definitions on a word or phrase in the Encyclopedia article, or any reference book article, by double-clicking a word or highlighting a phrase. 


1.	Highlight the phrase “Arctic Archipelago” located at the end of the first sentence.


2.	With the right mouse button (Macintosh: Control-click), click the highlighted phrase, and then on the shortcut menu, click Define. 


3.	Click outside the definition window to close it.


Exploring Related Topics


Often when you look up a topic, there will be related articles of interest near the entry about your topic. 


Words in color are Jump links. These lead to related material.


1.	Click on the link Alberta in the Encyclopedia article to see more information on the topic.


	A new, related article appears on the screen. 


2.	To return to the original Encyclopedia article on Canada, click the Back button.


You can also click the See Also button to view a list of Encyclopedia articles related to the current article.


1.	Click the See Also button on the Feature bar.


2.	Click British North America Act.


3.	Click the Back button.


Atlas 


The Concise Encarta World Atlas contains topographic maps of the world’s continents and countries, as well as maps of United States regions. You can copy these maps to other applications, view country and state flags, and play audio clips of the national anthems of many of the world’s nations. In addition, you can easily get to more information about the geographical location of your choice from within the maps through links to the Encyclopedia and Almanac.


1.	To go to the Atlas, click on the map picture in the Canada Encyclopedia article.


	A map of Canada appears. You can also go to the map by clicking the Books menu, clicking Atlas, and then clicking the Canada entry in the Articles list.


2.	To copy the map into another application, click the right mouse button (Macintosh: Control-click) on the map, and then in the shortcut menu, click Copy. 


	To copy the map directly into Word, PowerPoint, or Microsoft Excel, click the right mouse button (Control-click) on the map, then in the shortcut menu, click Copy To and select the desired application. The application will open and the map will be pasted.


3.	Go to your word processor or graphics program and choose where you want to insert the map, then paste the map.


	You can now size the picture or otherwise modify it to use as part of a printed or electronic document.


Using Maps to Explore


The Canadian map you see on your Bookshelf screen can be used to explore the Atlas even further. 


1.	With the map of Canada on the screen, click the Zoom Out button. 


	You see a map of the entire world.


2.	Click on the United States map, and then click on the Northwestern States.


	You see a map showing the states in this region.


3.	Click on the word Washington on the map.


	You can view or copy the Washington state flag, listen to the pronunciation of the state name, or jump to the Encyclopedia or Atlas articles for more information on the state.


4.	Click outside the Washington information box to close the window.


	The ease of linking to other information on a particular topic is one of the values of using Bookshelf—you can move from reference source to reference source as easily as moving to a new page in the same reference book. 


Leaving a Note


As you move through Bookshelf, it is easy to forget exactly where you found specific information. Sometimes you also want to note how you might use particular information in a project or paper. 


In Bookshelf you can easily leave notes for yourself or your students. Leave a note at the article or map currently on your screen.


1.	Click the Edit menu, then click Note.


	A dialog box appears that allows you to add the article and whatever notation you wish to add.


2.	Click Add Current Article to create a new note, then type the text for your note.


3.	Click the OK button to close the Notes window. 


	A small Notes icon is added to the right of the title of the article. As long as you continue to use Bookshelf 1996-97 on the same machine, your note will remain attached to the article.


4.	Click on the Notes icon in the upper right corner of the article to view the note again, and then close it.


You can view your notes from any article in Bookshelf by selecting Notes from the Edit menu, clicking the article note of your choice, and then clicking the Go To button.


Chronology


The People’s Chronology reference gives you access to a wide variety of factual, date-related information. You can use the Chronology to learn about important events in a year or category you specify.


1.	Click the Books menu, then click Chronology.


	The first entry in the Articles list shows a plus sign (+) to the left of the word “Canada.”


2.	Display the list of articles by clicking on the plus sign (+) to the left of the word “Canada.”


	The first article on Canada is displayed on the Article panel.


3.	To view additional Chronology articles on Canada, click another title in the Articles list. 


	You see that these articles are by specific date, but also by category.


Flipping Pages 


The Chronology is one place where you may want to browse through topics in chronological sequence, rather than by category. 


1.	Click on the right Page Arrow in the lower right corner of the screen.


	You see the next article that is chronologically after the article already displayed on the screen.


	The category title at the top of the article indicates which category the article is in. 


2.	Click on the right Page Arrow again. 


	As you move through the Chronology you’ll see the category titles change.


The navigation and “Find” features in Bookshelf 1996-97 Edition give you a variety of options for exploring material related to the particular topic you are researching. Later in this guide, you’ll learn how to find information in the Chronology by year and category, and how to use the Year in Review to view important events of 1995.


Almanac 


The World Almanac and Book of Facts 1996 is a general reference book of statistical data, contemporary facts, geographic information, and trivia that provides up-to-date, reliable information on people, places, and events in the United States and throughout the world. Bookshelf enhances the Almanac with pictures, charts, graphs, maps, and calendars.


When you search for a topic using the Almanac, you may find a variety of articles not directly related to the topics you are researching. The Almanac contains a diverse collection of information on a wide variety of topics. It is particularly helpful to use the Outline feature.


1.	Click the Books menu, then click 1996 Almanac.


	The first page of the Almanac appears.


2.	Click the Outline button on the Feature bar.


	The entries in the Almanac are organized into chapters. Each chapter is divided into categories based on a wide variety of subjects. Most categories are further divided into subcategories of information. 


3.	Click Nations of the World.


	The plus sign (+) indicates that there is more information in this topic. You see two sections under Nations of the World.


4.	Click Individual Nations to choose the subject.


5.	Scroll to Canada, then click Canada.


	You see a list of topics. The colored box next to them indicate that they are articles rather than subheadings.


6.	Click the topic Canadian Provinces.


	You see a table of information on the Canadian Provinces that you can copy into another application, such as Microsoft Excel, Microsoft Works, or Microsoft Word.


Quotations 


Next, examine the Columbia Dictionary of Quotations. There are several ways to locate just the right quote for your next presentation or report using Bookshelf 1996-97 Edition. 


You have an article about Canadian Provinces found in the Almanac on the screen.


Finding Quotations Using Find 


1.	To locate all quotations containing the word “Canada,” click the right mouse button (Macintosh: Control-click) on the word “Canada” at the top of the Almanac article. 


	A shortcut menu appears.


2.	On the shortcut menu, click Find In, and then in the second shortcut menu click Quotations.


	You then see a list of quotations that include the word “Canada.” In the Article window, you see a quotation and a bit of biographical information. At the bottom of the Article window, you will see a link—colored text—to related quotations. 


Finding Quotations Using Outline


A quick way to find a quote by category or author is to open the Outline.


1.	Click the Outline button at the bottom of the screen.


	You will now see a list of quotations that are related to Canada. 


2.	Click on the quote by John F. Kennedy.


3.	Highlight the quote in the Article window.


4.	With the right mouse button (Macintosh: Control-click), click the highlighted quote, and then in the shortcut menu, click Copy.


5.	Paste the quote into another application.


6.	In Bookshelf, click the Outline button again.


7.	Click the minus sign (–) to the left of “Canada and the Canadians” to close that portion of the outline.


8.	Scroll through the categories to see how the Quotations book is organized.


9.	Close the Outline window.


Internet Directory 96 


Some of the newest and most up-to-date sources of information are the many sites found on the Internet using the World Wide Web. While the Web is a source of almost limitless information, Web sites that provide both useful and accurate information can be hard to find.


Bookshelf 1996-97 Edition has added to its collection of references an annotated list of Internet sites. When you search for a topic or a particular word, Bookshelf searches in a list of nearly 5,000 Web sites. The Internet Directory is a useful tool for the student, the researcher, the casual Internet enthusiast—anyone looking for possible Internet destinations.


1.	Click the Books menu, then click Internet Directory 96.


	You see a list of Internet articles related to Canada.


2.	In the Articles list, scroll to locate the topic Canada’s SchoolNet, and then click it.


	The Article panel displays information about the Internet site and a link to the site.


	After the word “Access” you see the Internet address. When you click this link, a hypertext document called a “home page” is displayed.  The World Wide Web is a system for navigating the Internet using hypertext links. When you use a multimedia web browser, the World Wide Web appears as a collection of text, pictures, sounds, and digital movies.


3.	Click on the URL address (colored text after “Access:”).


	If you are connected to the Internet and have a Web browser, you can go to Web sites while you’re in Bookshelf. 


	If you do not have a Web browser, you can install Internet Explorer at any time from your Bookshelf 1996-97 CD-ROM. Internet Explorer is available for Windows 95, Windows 3.1, or Macintosh operating environments.


	For Internet Explorer updates and add-ins, see http://www.microsoft.com/ie/.


Updating the Internet Directory 96 


The Internet is constantly evolving. Sites change, addresses become discontinued or invalid, and new sites are always being created. Updates to the Internet Directory 96 will be available on the 5th of every month.


To view a listing of new sites that have become available and were not included in this edition of Bookshelf, follow these steps.


1.	Click the Books menu, then click Internet Directory. 


2.	When it opens to the front page, click New Internet Resources. 


	This takes you to a searchable Web site of new Internet listings.


3.	On the front page of the Internet Directory 96, click Update Your Internet Directory.


	If you have an Internet connection, you can now download a file containing updated addresses of the Internet Directory 96.


	You can also print a copy of the information about the Web site, as well as the address. On the File menu, click Print Article. Remember that you can print any article from Bookshelf in this manner. 


Using the Thesaurus 


We looked up Canada in All Books, and then took a closer look at a Dictionary entry. Then we examined entries for Canada in most of the other reference books. However, we have not yet examined the Thesaurus. 


Recall that a thesaurus is used to search for related words with similar meanings. You most often use the Thesaurus when you are looking for just the right word when writing a paper or report. 


Roget’s Original Thesaurus classifies words and phrases according to underlying ideas and meaning. This indispensable companion for writers and speakers will help you expand your vocabulary, improve precision of expression, avoid repetition, or simply recall a word that has slipped your mind. 


1.	With the right mouse button (Macintosh: Control-click), click on a word in the current article, click Find In, and then click Thesaurus. 


	In the Articles list, you see a list of articles in the Thesaurus that include the word or phrase you searched for.


2.	Click an article in the Articles list that corresponds to the desired meaning of the word.


	The article displays in the Article window.


The Thesaurus is organized into six categories. If you have an article on display, the article’s title is highlighted in the Outline. If no article is open, the beginning of the outline appears.


1.	Click the Outline button to search for an article by category. 


2.	To view the titles within one of the Outline’s categories, click the plus sign (+) next to the category.


3.	To hide the titles under a category, click the minus sign (–) next to the category.


	A list of related words appears on the right. Words that lead to other entries in the Thesaurus are in colored text. 


4.	Click the Back List button at the bottom of the window.


	You see the list of articles that you have examined since you began your session with Bookshelf. You can select any one of the items from this list to return to an article that you want to view again.


Using the Address Builder  


Address Builder provides a quick, easy way to locate the city, state, and ZIP code for most U.S. addresses. You can use the Address Builder while in Bookshelf. While working in other applications, you can use QuickShelf to use the Address Builder.


1. 	Click the Address Builder  button  on the Feature bar.


2.	Click in the Street text box and type your street address.


3.	Click the Find button.


	A list of possible addresses appears.


4.	Use the scroll bar if necessary to locate your town or city. Entering the state abbreviation in the state text box is a good way to narrow the search.


5.	Click the Copy Address button, then click the Close button.


	The complete address you have selected is copied onto the Clipboard. 


6.	Go to the application of your choice, perhaps a word processor or database, then select Paste.


	The address you selected in Bookshelf is copied into your document.


Using the Year in Review


With the Year in Review feature, you can scroll through collage-like images covering noteworthy events, facts, people, and places in 1995. Quickly jump to the associated article by clicking the image.


1.	Click the Year in Review button on the Feature bar.


2.	To hear an audio clip about events, hold the mouse cursor over Year in Review images. Note that some images have no corresponding audio clip.


3.	To jump to an article about an event, click the corresponding Year in Review image. 


Finding Information 


With Bookshelf 1996-97 Edition, it is very easy to search across all of the references. However, the number of articles that match your search criteria can be overwhelming. As an educator familiar with most of these references, you can process information from multiple sources. However, you can overwhelm your students with information,� especially if they are not familiar with the individual references.


Take your time. Introduce students to each source with which they are not familiar. Only when they understand the kind of information that is found in each reference are they ready to deal with the amount of information that appears when you search All Books.


Since you will most likely find a large number of articles on almost any topic you choose, you need to learn how to narrow your search to find the particular information you need.


Finding Information


Often when you are using reference books, you are searching for information on a particular topic. As you were exploring Canada in each of the previous sections, perhaps you encountered some information that you would like to pursue further. Use either a topic that interests you or follow the example using “Washington” shown below to learn how to search for information in more detail. Of course, the search techniques described will work whether you are using one reference book or all of them. 


1.	On the Contents panel, click the Find tab.


2.	Click the Books menu, then click All Books.


3.	Enter the topic Washington state in the Find text box, then click the Find button.


	A list of articles that contain the words “Washington state” appears. 


	In this case, 416 articles were located.


4.	Examine several of the articles from the Articles list. 


There are so many articles that include the words “Washington state” that it will take some time to locate the specific information you are seeking on the topic. In addition, several of the articles selected when we used the above criteria seem to have very little to do with the state of Washington.


In fact, Bookshelf searched for any articles that contained the words “Washington” and “state.” We wanted articles containing “Washington state.” To find such articles, place quotation marks outside of the search phrase.


5.	Enter quotation marks around the phrase Washington state in the Find text box, then click Find.


	Twenty-six articles in Bookshelf contain the phrase “Washington state.” The information in these articles is closer to the type of information that you are interested in.


Create an Advanced Find


When you change from looking for an individual word to searching for a phrase, the number of articles located will be smaller.


There are other ways to narrow your search. You can use operators such as and, or, not, and near to define search criteria. This allows you to write specific criteria to focus your search. In this example, we’ll again use Washington state.


1.	Enter Washington in the Find box, then click Find. 


	As you have seen before, you locate a large number of articles using a simple Find.


2.	Type the word and and the word senator after “Washington” in the text box.


	Do not put quotation marks around the search words.


	The number of articles that appears is reduced from the first search.


3.	Click the Advanced Find button on the Feature bar and add and “election winner” to the search criteria, then click the Find button.


	Be sure to put quotation marks around “election winner.”


4.	Be sure that All Books is checked, and that no checks appear next to the Audio, Animations and Videos, or Images options.


	The search now reveals only one article that matches the search criteria. This helps you easily locate the names of your state senators or representatives.


You can use Advanced Find to quickly narrow your search by category or topic as demonstrated in the previous steps. You can also use Find to locate information by a specific date and containing media elements.


1.	Click the Advanced Find button.


2.	Type 19?? and “Washington state”.


	The question marks in place of the last two numbers in the date indicate we are searching for all articles that include any date in the 1900’s (1900–most current information) that also include “Washington state” and an image.


3.	Click All Books, and then click Images.


4.	Click Find.


The other operators that you can use are OR, NOT, and NEAR. 


•	OR locates any of the words in your search. For example, “senator or representative” in the Find box would locate articles containing “senator,” “representative,” or both.


•	NOT causes Bookshelf to look for articles that do not contain the information after NOT. NOT is used with other operators. For example, 


	“election winners” NOT senators 


	locates articles about election winners that do not contain the word “senators.”


•	NEAR searches for the second word in a phrase that is, only a few words away from the first word. That is “Washington near senator” finds articles with the words “Washington” and “senator” next to each other or separated by a few words.


Using the Gallery Tab 


You have seen that Bookshelf 1996-97 Edition contains text, sound, and graphics. You may also have seen some short videos and animations in your explorations. If you want to examine articles in Bookshelf by media, you use the Gallery tab.


1.	On the Contents panel, click the Gallery Tab, then click the Audio button.


	You see a list of all of the audio clips in Bookshelf. 


2.	Select any article, then click the audio icon to play it.


Spend a bit of time exploring Animations and Videos and Images. While it is interesting to see the large variety of media in Bookshelf, these articles are of more value if you can search by topic and by media.


1.	Click the Advanced Find button on the Feature bar.


	Take a look at the dialog box. Near the bottom are choices for media.


2.	Enter the name of your state or country in the Find box.


3.	Click the Audio button and Picture button, then click the Find button.


	Take a few minutes to explore the articles. Can you find a bit of a speech? How about some music?


Using Bookshelf 1996-97 with other applications 


QuickShelfª brings the full power of Bookshelf 1996-97 references to the other programs you use. As you are working with another application and need additional data for a word or phrase, highlight the word or phrase and use QuickShelf to look up the specific information in any of the Bookshelf 1996-97 references.


In the Windows operating system, click a book in the QuickShelf toolbar to search for information on the highlighted word or phrase in any Bookshelf reference.


For the Macintosh, select a book on the QuickShelf menu to perform a search. 


To learn more about Quickshelf, on the Bookshelf Help menu choose Help Contents, then type Quickshelf.


�
Classroom Activities for �Bookshelf 1996-97 Edition


Here are some suggestions for using Bookshelf 1996-97 Edition in your classroom. You can use them as a source of new activities, as ideas to incorporate into activities already under way or as models for putting Bookshelf 1996-97 to work in your classroom.


Getting Acquainted with Bookshelf 


Use your state as the basis of an exploration of the sources in Bookshelf. Work through activities similar to those given in the Getting Started section of this booklet. Give students time to try the various activities in small groups. Then discuss the kind of information located in each reference and the value of the information found by different groups.


As students progress, spend an increasing amount of time talking about how to deal with the vast amount of information that they are likely to find in Bookshelf. Be sure to teach them how to use the Find feature and how to narrow a search.


�
Think About Size 


Bookshelf 1996-97 contains vast amounts of information in a variety of formats. Spend some time helping students understand how much information is stored on the small CD-ROM that they put into the computer.


Compare with Traditional Books


Have groups of students go to the library and find the reference sources that are included in Bookshelf 1996-97. If your library doesn’t have the exact sources, locate similar ones. Your librarian can help you.


Stack the books in a pile on a table so that students can see in the “traditional” measure of information how much material is on the CD.


Next have groups of students browse the various traditional references and compare them with those on the CD-ROM. They should try to find items that have been added to the CD such as sound, graphics, and video.


Discuss with the class how much more information they think is on the CD than in the traditional books.


Storing Text


Discuss the storage capacity of books versus modern media such as disks and CD-ROMs. Here are some facts that may help:


•	1 K (kilobyte) equals 1024 bytes; 1 byte equals a character such as a letter, number, or space.


•	A single-spaced page contains 2–3K of text.


•	A typical high-density floppy disk used in personal computers today holds about 1.4 MB (megabytes) = 1400K. That is, roughly 1000K is equal to 1 MB.


•	Hard drives on computers today often hold between 500 MB and 1 GB (gigabyte) of information. Since 1 GB equals 1000 MB, computer hard drives are likely to store between 500,000 and 1,000,000K.


•	A typical CD-ROM holds 640 MB, which is 640,000,000 K.


Have students compare various storage media. How many books fit on a CD-ROM if they are all text? How many pages fit on a floppy disk? Questions such as this serve as excellent exercises in a math class and help students gain an awareness of the impact of large amounts of digital information in our society today. 


Storing Other Media


Pictures and sound take more space than text. Continue exploring how much information is stored on Bookshelf 1996-97 Edition. Here are some facts to help. You may need Bookshelf to get information on unfamiliar terms.


•	Stereo music recorded at 22kHz (Kilohertz) requires 5,280 K per minute.


•	Stereo of CD quality recorded at 44kHz requires 10,560 K per minute.


•	Low quality mono sound at 11kHz sampled at 8 bits needs 660 K per minute.


•	For a simple graphic image, such as a TIFF, that is primarily black and white, a 4 x 5 inch image at 72 dpi needs 13K, at 150 dpi 56K, and at 300 dpi 220K. The same image with simple 8-bit color at 72 dpi needs 102K, at 150 dpi needs 440K, and at 300 dpi needs 1758K.


•	For a TIFF image of 4 x 5 inches that gives a more realistic picture with smoothly shaded or photo-type quality the numbers are 72 dpi at 103K, 150 dpi at 44K, and 300 dpi at 1,758K. If you increase the color from 8 bit to 24 bit which is much better quality the 72 dpi needs 304K, the 150 dpi needs 1,319K, and the 300dpi needs 5,274K.


•	Video requirements are tremendous. One minute of animation at 480-600 pixels using 30 frames per second (television quality) will take about 50 hours to complete the creation process, called rendering. This one minute of animation needs about 200–300MB of storage. If the video is kept at film quality rendering of 30 frames per second at 2000 by 3000 pixels, only 4 seconds of film needs 1GB of storage.


The figures indicated are for the digital file as it would be created if no compression or manipulation of the data was done. In order to include the many resources in Bookshelf, a way to compress data was selected that reduces storage requirements with little or no loss of quality.


Access to Information in the Future


As progress is made in developing new compression methods, new ways of storing data, and new ways of reading/writing digital data, the quality of digital information will continue to improve. In the future, it may be possible to have access to the great libraries, museums, and art galleries of the world and have items of particular interest downloaded to your own computer for browsing at your leisure.


Role Playing 


Have each student take on the role of a figure in history. This could be either someone current or someone from the past. The student could become a famous person, or create a character typical of the time period and culture they choose.


Examine the Time Period


Have students begin with the Chronology. They can browse the time period that interests them. They can then narrow the time period that they want to consider.


Next have them use the Quotations reference or see examine famous sayings from the time period of their choice. This can lead them either to an individual in history or give them a flavor of the times.


Develop a Character


Once students have decided on their character—a famous individual or a fictional person—they can use the Encyclopedia and perhaps the Almanac to find out more about either a particular person or a typical person from their time period. They can use the Dictionary and the Encyclopedia to find more information about artifacts from the time period they are studying.


The Atlas can be used to examine the part of the world from which their character comes. 


Present a Final Product


Students should then prepare a final presentation to share their findings with the class. They can write a play, create a report, publish a hypothetical newspaper, or design a hypermedia presentation. Of course they will use the traditional tools of the Dictionary or Thesaurus to help with their writing. However, they should also consider using the ability to copy images from Bookshelf as a way to enhance their final presentation.


Alternate Histories 


Often the basis for the study of history is political history. The topics studied are linked to political figures, wars, and the establishment of governments. There are many other ways to look at history. Use Bookshelf to help students see a broader picture.


First, create a series of themes that students or groups of students can study. Most likely, you will want to pick a time period; for example, 1800 to 1850. Have different groups of students study different aspects of that period: history of art and music, history of technology, history of fashion, history of women, and so forth.


Students can use the Find and Advanced Find features of Bookshelf to look at the particular area they are to study. Links from the articles they locate can lead to related topics, resulting in a rich exploration of each topic through the use of the many resources in Bookshelf.


For example, students studying music history can use the Gallery to locate audio clips and present their material as a mini-concert.


Those studying fashion can locate pictures to produce a document to share with the class. They might find a video clip that shares fashion information simply by noting the way the people in films are dressed.


Explore the Weather 


In conjunction with work in a science class, use the resources in Bookshelf 1996-97 to learn more about the weather. You might collect local weather data using a weather station at the school or by making use of local weather reports in the media.


Explore Historical Weather Data


Use the Almanac to learn more about the weather in your area or in some part of the world that you are studying. Bookshelf contains weather information from the National Oceanic and Aeronautic Administration (NOAA). Search for such topics as “NOAA and temperature” or “NOAA and precipitation.”


Use a spreadsheet such as the one in Microsoft Works to collect weather data. Students can create graphs and charts to illustrate the weather topic of their choice.


Use Bookshelf to learn about such topics as wind chill, highs and lows, and National Weather Service warnings. Using the Page Arrow button in the Almanac once you locate a page of weather data leads to many interesting collections of related data.


Explore Current Weather Data


In addition to collecting local weather information, perhaps using a spreadsheet, use the Internet Directory to find more about current weather information.


Examine several of the Web sites that are located by searching for the word “weather” in the Internet Directory. Use these sites to track weather elsewhere and compare it with your own local weather.


Create a Multimedia Presentation 


There are a number of multimedia authoring tools that are commonly used in schools: HyperCard¨, HyperStudio¨, LinkWayª, and ToolBook¨, among others. If your students are developing Web Pages, you can use an HTML editor to create pages displaying student products. Bookshelf 1996-97 is the perfect tool to use when creating multimedia presentations. Even if you don’t have access to a hypermedia product, you can create interesting presentations in Microsoft PowerPoint or in a word processor such as Microsoft Word or Microsoft Works, that can display images and play sounds.


Design the Presentation


Once students select a topic, they should do some preliminary research. They can use the appropriate references in Bookshelf to locate information relevant to their topic. Using the Notes feature is a good way to keep track of their research steps. You may also want to have students collect information that they find relevant by copying and pasting it into a word processing document.


Next students should think about what information should go into their presentation. They should plan text, graphics, and sound and how these elements will be interrelated and interconnected.


Construct the Document


Next, students should construct the template for their document and begin to fill it with the text and graphics that they have collected. They can even copy the sound of the pronunciation of words and include it in the presentation if the application they are using accepts sound.


Critique the Presentation


Students should work in pairs or small groups to critique each other’s work, both for content and presentation. After a critiquing session, students need time to make changes in their product. You may want to have students critique each other’s work several times.


Exploring Letters, Words, and Type 


When students use the computer and learn word processing software such as Microsoft Works and Microsoft Word, they have access to a wide variety of type faces, type styles, and type fonts. Many students become fascinated with using different type in their work. Take advantage of these natural interests to learn more about the individual letters and different kinds of type.


Learning about Letters


Using the Dictionary, look up letters of the alphabet to learn about the history of the letter. 


Examining letters may lead to exploration of different cultures. Use the Chronology and the Encyclopedia to learn more about when the various cultures thrived and what other contributions they made to history.


With younger children, you might have a “letter of the week” and focus on learning words that begin with that letter. Students can use Bookshelf to learn more about the words they are assigned each week.


Learn About Words


In addition to exploring the history of letters, you can have students explore the history of words. Use the Advanced Find feature to search the Dictionary for such topics and “French” and “word history” to learn about words of French origin. They could also explore terms that have been adapted from subject areas such as psychology or computer technology.


Have a category of the week and feature words of a particular origin: language, culture, discipline, slang, and so forth.


Learn About Printing


Explore the history of type and printing. Use the Chronology and the Encyclopedia to look for “printing.” Examine the impact of printing and the printing press on society. Discuss ways in which the availability of the computer is having an impact on society similar to the impact of the printing press.


Learn About Type


Use the Dictionary to look up such technical terms as “font,” “typeface,” and “type style.” The menu choice Font on most computer systems is technically incorrect. A ”typeface” is generally selected from the Font menu.


Next, use the Find feature to search the Dictionary, Encyclopedia, and Almanac for information about the term “typeface.” Many articles about type designers and kinds of type appear. 


Once students have gained some knowledge about different kinds of type, have them explore the type available on your computer systems and use interesting type to prepare signs or posters.


Exploring the Present 


Have students examine recent history from the time of their parents’ births through the time of their birth to the present.


Exploring the Previous Generation


Have students find out in what years their parents were born. Then have them use the Chronology to find out what important events occurred during those years. You may want to group students by the years their parents were born.


Create a database of important events by year using a database such as Microsoft Works. Have students use the Bookshelf resources to find out at least one important fact about each entry in the database. Add the information to the database.


Exploring Students’ Lives


Next, have students repeat the above activity for their own dates of birth. Create a second database of student information.


Next use the Year in Review to locate important information about the present. Again, have students create a database.


With all three databases complete, talk about the changes that have happened in each generation—their parents’ and theirs. Compare the rate of change. Talk about the effects of the current rapid changes on our society. 


Learn About Music 


Because Bookshelf 1996-97 contains many audio examples, it is an excellent tool for learning more about music. Students can look up topics and then listen to examples.


Elements of Music


Have students explore such topics as rhythm, key, pitch, and harmony. Search the Encyclopedia, and then have students listen to the examples they find there. Use the See Also button to explore related articles.


Forms of Music 


Explore various forms of music such as jazz or country. Or examine classical forms such a fugues and symphonies. 


Locate these topics in the Encyclopedia. Use the See Also button to explore related topics.


Learn about Composers


Have students learn more about composers who interest them. Perhaps they learned about a particular composer as they explored the various musical forms. They can create a report about the composer using a word processor such as Microsoft Word. They can include both images and sound clips of pronunciation of terms in their report. 


If the students have musical skills, they can try to create music that sounds like the work of the composer they selected.
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